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1 Revision History

The revision history describes the changes that were implemented in the document. The changes are
listed by revision, starting with the current publication.

1.1 Revision 9.0

The following is a summary of the changes made in this revision.

*  Updated the document for Libero SoC v12.6.
. Removed the references to Libero version numbers.

1.2 Revision 8.0

The document was updated for Libero v11.8 SP2 software release.

1.3 Revision 7.0

The following is a summary of the changes in revision 7.0 of this document.

. Libero SoC, FlashPro, and SoftConsole design requirements were updated. For more information,
see Design Requirements, page 4.

*  Throughout the document, the names of SoftConsole projects used in the demo design (and the
associated figures) were updated.

1.4 Revision 6.0

The document was updated for Libero v11.7 software release details (SAR 77020).

1.5 Revision 5.0

The document was updated for Libero v11.6 software release (SAR 53219).

1.6 Revision 4.0

The document was updated for Libero v11.5 software release (SAR 53219).

1.7 Revision 3.0

The following is a summary of the changes in revision 3.0 of this document.

*  The document was updated for Libero v11.4 software release details (SAR 60795).
*  The document was updated for SmartFusion2 Advanced Development Board details (SAR 60795).

1.8 Revision 2.0

The document was updated to include TFTP server (SAR 55038).

1.9 Revision 1.0

The document was updated for Libero v11.2 software release (SAR 53219).

110 Revision 0.0

Revision 0.0 was the first publication of this document.
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Running Webserver and TFTP Server on
SmartFusion2 Device

2.1

Figure 1

The demo design associated with this document shows the Tri-Speed Ethernet Medium Access
Controller (TSEMAC) features of the SmartFusion®2 device. The design has a Webserver and a Trivial
File Transfer Protocol (TFTP) server implemented on a SmartFusion2 Advanced Development Board.
For more information about this board, refer to UG0557: SmartFusion2 SoC FPGA Advanced
Development Kit User Guide.

The design demonstrates the following.

*  Use of SmartFusion2 Ethernet MAC connected to a Serial Gigabit Media Independent Interface
(SGMII) PHY.

* Integration of SmartFusion2 MAC driver with IwIP TCP/IP stack and FreeRTOS operating system.

* Implementation of Webserver on the SmartFusion2 Advanced Development Board.

* Implementation of TFTP server on the SmartFusion2 Advanced Development Board.

*  Procedure to run Webserver and TFTP server designs on the SmartFusion2 Advanced
Development Board.

The Microcontroller Subsystem (MSS) of the SmartFusion2 device has an instance of the TSEMAC
peripheral, which can be configured between the host PC and the Ethernet network at 10/100/1000 Mbps
data transfer rates (line speeds).

For more information about the TSEMAC interface for SmartFusion2 devices, refer to UG03317:
SmartFusion2 Microcontroller Subsystem User Guide.

Webserver and TFTP Server Demo Design Layers

The Webserver and TFTP server demo designs have the following layers.

*  Application layer
+  Transport layer (IwIP TCP/IP stack)
+ RTOS and firmware layer

The following figure is a block diagram of the three layers in the Webserver and TFTP server applications
on the SmartFusion2 device.

Webserver and TFTP Server Applications on a SmartFusion2 FPGA

Application Layer
(HTTP, TFTP)

Transport Layer
(wIP TCP/IP Stack) FreeRTOS

Firmware Layer

SmartFusion2 Advanced
Development Kit (HW)

Microsemi Proprietary DG0472 Revision 9.0 2
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Application Layer

The Webserver handles the HTTP request from the client (host PC) browser and transfers the static
pages to the client in response to its request. When the IP address (for example, http://10.60.3.25) is
typed in the address bar of the browser, an HTTP request is sent to the port associated with the
Webserver. The Webserver then interprets the request and responds to the client with the requested
page or resource.

The TFTP client (the host PC) transfers files to the SmartFusion2 device (the TFTP server) using the
TFTP PUT command. Transferred files are stored in the SmartFusion2 Advanced Development Board
external flash memory, which is connected to the SmartFusion2 SPI_0 interface. The File Allocation
Table (FAT) file system on the SPI flash is used to display the files available in SPI flash memory.

Transport Layer (IwlP TCP/IP Stack)

The IwIP TCP/IP stack, developed by Adam Dunkels at the Swedish Institute of Computer Science
(SICS), is suitable for embedded systems because of its low system resource usage. The IwIP stack can
be used with or without an operating system. It consists of actual implementations of IP, ICMP, UDP, and
TCP protocols, as well as the support functions such as buffer and memory management.

For more information about IwIP design and implementation, refer to
www.sics.se/~adam/Iwip/doc/Iwip.pdf.

IwlP is available (under a BSD license) in C source-code format for download at
http://download.savannah.gnu.org/releases/Iwip/.

RTOS and Firmware Layer

FreeRTOS is an open-source, real-time operating system kernel. In this demo, FreeRTOS is used to
prioritize and schedule tasks. For more information about FreeRTOS, including the latest source code,
refer to http://www.freertos.org.

The firmware provides software drivers to configure and control the following MSS components.

. Ethernet MAC

+  MMUART
+ GPIO

+ SPI

+ RTC

Microsemi Proprietary DG0472 Revision 9.0 3
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2.2 Design Requirements

The following table lists the hardware and software requirements for running this demo design.

Table 1+ Design Requirements

Requirement

Version

Operating System

64 bit Windows 7 and 10

Hardware

SmartFusion2 Advanced Development Kit with:
* 12V adapter
+ USB Ato mini-B cable

Rev B or later

Ethernet cable

RJ45

Software

FlashPro Express

Libero® System-on-Chip (SoC) for viewing the design
files

SoftConsole

MSS Ethernet MAC drivers

Refer to the readme. txt file provided in the design
files for the software versions used with this reference
design.

Host PC drivers

USB to UART drivers

A serial terminal emulation program

HyperTerminal, TeraTerm, or PuTTY

Browser

Mozilla Firefox or Internet Explorer

Note: Libero SmartDesign and configuration screen shots shown in this guide are for illustration purpose only.

Open the Libero design to see the latest updates.

2.3 Prerequisites

Before you begin:

Download and install Libero SoC (as indicated in the website for this design) on the host PC from the

following location.

https.:.//www.microsemi.com/product-directory/design-resources/1750-libero-soc

Microsemi Proprietary DG0472 Revision 9.0
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Demo Design

The demo design files are available for download at
http://soc.microsemi.com/download/rsc/?f=m2s_dg0472_df

The demo design files include:

* AlLibero SoC hardware project with the corresponding SoftConsole firmware project
+  Sample files to be transferred to the SmartFusion2 device using the TFTP server

*  Programming files

* A Readme.txt file

The following figure shows the top-level structure of the demo design files. For more information, refer to
the Readme. txt file.

Demo Design Files Top-Level Structure
<download folder>

{——— SF2 Webserver Tftp TCP_Demo_ DF

—— Libero
ProgrammingFiles

sample_files

—— Readme.txt

Demo Design Features

*  Webserver: Displays options for the following:
+ RTC and Ethernet interface data display
*  LED blinking
*  HyperTerminal display
*  SmartFusion2 Google Search
»  TFTP server: Transfers files from the host PC to the SmartFusion2 Advanced Development Board

Demo Design Description

The demo design is implemented using an SGMII PHY interface, by configuring the TSEMAC for ten-bit
interface (TBI) operation. For more information about the TSEMAC TBI interface, refer to UG0331:
SmartFusion2 Microcontroller Subsystem User Guide.

This section provides detailed information about the Libero SoC hardware project and SoftConsole
firmware project associated with the demo design.

Microsemi Proprietary DG0472 Revision 9.0 5
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Libero SoC Hardware Project

The following figure shows the Libero SoC top-level hardware design implementation for the demo
design.

Figure 3+ Libero SoC Top-Level Hardware Design
SB_sb_0
4 FAB RESET N FOWER_ON_RESET. MNP ¥ HIRNESE
p CLD_FAD DR READY BB X FAD Y
p DEVRST_N SDIF_READY [p X D
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¢ @l SDIF2_CORE RESET M MVUART 0_FADSE <o QEINUERT 0 BADS
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B SO FERST N NT_ANSE® HH
MT DCHE X i
INIT_AFE S FOLK [—
NIT_AFE_S_FRESET_N
FAE_CCC_ANSEIg
FAB CCC G0 X
FAE CCC @3 X
FAB 0OC_Lock X —
WA TBL FABRICE®
MAC_TEL RO CLKFO
MAC_TBL RX_CLKF1
MBC_TEL GTX_CLK
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p EFCS_3_RESET_N REFCLII_OUTIP X
AFE S FRESET_N FADs_CUTED [FADe CUT
L APE S FCLK EFCS 3 OUTE
FHFADs_IN EFCS_3 READY X
PEECS 2 IN EFCS_3_RX_DATAR(]
- 4 3 TX_DATAIS:0] EFCE 3 RX VAL X
L EPCS 3 PWRON EFCS_ 3 R DLE X
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The Libero SoC hardware project uses the following SmartFusion2 MSS resources and IP.

+  TSEMAC TBI interface for supporting Ethernet functionality on the SmartFusion2 device

*  MMUART_O interface for RS-232 communications on the SmartFusion2 Advanced Development Kit

»  SPI_0interface for accessing external flash memory

*  General Purpose Input and Output (GPIO) for connecting to the LEDs on the board

+ Dedicated input pad 0 as the clock source

+ SERDES_IF IP high-speed serial interface configured for SerDesIF_3 EPCS Lane 3 (as shown in
the following figure)

Figure 4+ High-Speed Serial Interface Configuration

v < - ~ = ~
1 High Speed Serial Interface Configurator TPEDEE ] LY W } e . Pre . - — v —— L":" E‘g
Identification
() SerDesIF_0 () SerDesIF_1 () SerDesIF_2 @ SerDesIF_3 Simulation Level
Protocol Configuration
Protocol 1 Protocol 2
Type EPCS =2 Type MNone
Number of Lanes [xl '] [Lane 3 = Number of Lanes
Lane Configuration
Lane 0 Lane 1 Lane 2 Lane 3
Speed Custom Speed
Reference Clock Source REFCLK1 (Differential) -
PHY RefClk Frequency { MHz ) 125
Data Rate ( Mbps ) 1250 Mbps (10 bit) -
Data Width 10
FPGA Interface Frequency ( MHz ) 125
VCO Rate ( MHz ) 2500
Signal Integrity Options Register Configuration
Signal Integrity Options ... Edit Registers ...
L -

For more information about high-speed serial interfaces, refer to UG0447: IGLOOZ2 and SmartFusion2

High Speed Serial Interfaces User Guide.

Microsemi Proprietary DG0472 Revision 9.0
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Each LED and PHY interface signal on the SmartFusion2 board has a package pin assigned to it.
The following table lists the LED port names and corresponding package pins.

Table 2 « LED to Package Pin Assignment

Port Name Package Pin
LED_1 D26
LED 2 F26
LED_3 A27
LED 4 C26
LED 5 Cc28
LED_6 B27
LED_7 c27
LED_8 E26

The following table lists the PHY interface signals and corresponding package pins

Table 3 * PHY Interface Signal to Package Pin Assignment

Port Name Direction Package Pin
PHY_MDC Output F3
PHY_MDIO Input K7
PHY_RST Output F2

Microsemi Proprietary DG0472 Revision 9.0 8
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SoftConsole Firmware Project
The following stacks available in the SoftConsole Project Explorer are used in this demo design.

* |wIP TCP/IP stack v1.4.1
. FreeRTOS

The following figure shows the directory structure of the demo design in SoftConsole.

Demo Design Directory Structure in SoftConsole Project

L5 Project Explorer &2
a [ TFTP Server
> f;‘ Binaries
> [ Includes
> i= Application
> = CMSIS
> [= Debug
> [= drivers
> [= drivers_config
> [= FatFs
> [= FreeRTOS
> [= hal
> G2 hwip-1.41
> [= micronlgflash
> [= Release
> = TFTP
> FreeRTOSConfig.h
» L€ main.c
» [ mscc_post_hw_cfg_init.c
> SB_hw_platform.h
» [ sys_cfg.c
s sys_cfg.h
a |l Webserver
> f;‘ Binaries
> [ Includes
> i= Application
> = CMSIS
> [= Debug
> [= drivers
> [= drivers_config
> = FreeRTOS
> [= hal
> G2 hwip-1.41
> [= Release
> FreeRTOSConfig.h
» [ main.c
» L€ mscc_post_hw_cfg_init.c
> SB_hw_platform.h
» [ sys_cfg.c
s sys_cfg.h

The SoftConsole workspace consists of the following projects.

TFTP_Server: contains the TFTP server application (which uses LWIP, FreeRTOS, and FatFs) and
all the firmware and hardware abstraction layers that correspond to the hardware design.
Webserver: contains the Webserver application (which uses LWIP and FreeRTOS) and all the
firmware and hardware abstraction layers that correspond to the hardware design.

Microsemi Proprietary DG0472 Revision 9.0 9
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Figure 6+ Demo Design Driver Versions
Generate | I Instance Name: Core Type Version Compatible Hardware Instance
i @4 I SmartFusion2_CMSIS 0 SmartFusion?_CMSIS 2.3.105 + |5B_sb_MSS
2 g‘ I SmartFusion2_MSS_Ethernet MAC Driver_0 SmartFusion?_MSS_Ethernet MAC_Driver 3.1.100 + |5B_sb_MSS:MAC
|3 B, SmartFusion2_MS5_GPIO Driver_0 SmartFusion2_MSS_GPIO_Driver 2.1.102 v |5B_sb_MSS:GPIO
n [&] By SmartFusion2_MSS_HPDMA Driver 0 SmartFusion2_MSS_HPDMA_Driver [2.2.100 v [5B_sh_Mss
5 By SmertFusion2_MSS_MMUART Driver_0 SmartFusion2_MSS_MMUART Driver 2.1.100 + |SB_sb_MSS:MMUART_0
3 D !; SmartFusion2_MS5_NVM_Driver_0 Smar tFusion2_MSS_NVM_Driver 2.4.100 » |SB_sb_MSS
7 & IRy | SmartFusion2_MSS_PDIMA_Driver_0 SmartFusion?_MSS_PDMA_Driver 2.0.102  |SB_sb_MSS:DMA
8 B SmartFusion2_MSS_RTC Driver_ 0 SmartFusion2_MSS_RTC_Driver 2.2.100 ~ |SB_sb_MSS:RTC
9 Fi D 0 Dy 2.2.101 + [EEEY 0
4 SmartFusion2_MSS_System_Services Driver_0 SmartFusion2_MSS_System_Services_Driver 2.7.100 » |SB_sb_MsS
=]
11 ‘ ‘ By SmartFusion2_MS5_Timer_Driver_0 ‘Smartfusmnz,Mssjmsr,Driver Iz‘z‘mu v]Sﬁ,sh,Mss

N
)]

Note:

Figure

-

Setting Up the Demo Design

The following steps describe how to set up the demo for SmartFusion2 Advanced Development Board.

1. Connect the host PC to the J33 connector using a USB A to mini-B cable.
The COM ports are automatically detected and displayed in the Device Manager window.

If the COM ports are not detected automatically, install the FTDI D2XX driver for serial terminal

communication through the FTDI mini-USB cable. The driver, along with the installation guide, is
available at www.microsemi.com/soc/documents/CDM_2.08.24 _WHQL_ Certified.zip.

2. Right-click each of the four detected COM ports, and click Properties to find the port with the
location on USB FP5 Serial Converter C, as shown in the following figure.

7+ Device Manager Window

=4 Device Manager

File

= @ EIHE

Action  View Help

| @B

a 24 W764-onteddhusl

i -1M Computer

b = Disk drives

b B Display adapters

b i) DVD/CD-ROM drives

|'> tﬁ Human Interface Devices
b g IDE ATA/ATAPI controllers
b -EF Jungo
|.> ]
b --B Mice and other pointing devices

b | Monitors

b - Metwork adapters

b i MoMachine USE Host Adapter

T Ports (COM & LPT)

. f?' Communications Port (COML)
YT FlashPro5 Port (COMSE)

? FlashPro5 Port (COMEZ)

Y3 FlashPro5 Port (COMS0}|

? FlashPro5 Port (COM31)

? Intel(R) Active Management Technology - 5C
Processors

Keyboards

I.> n
|.> -%| Sound, video and game controllers
b g8 System devices

b i Universal Serial Bus controllers

FlashPro5 Port (COMS0) Properties

General | Port Settings | Driver | Details |

FlashPro5 Port (COMS0)
Device type: Ports (COM & LPT)
Manufacturer: Microsemi
Location: I on USE FP% Seral Converter C I
Device status
This device is working propery. =
[ ok || Caneel |

3. Make a note of the COM port number for use during serial terminal configuration. For more
information, refer to Running the Demo Design, page 11.

Microsemi Proprietary DG0472 Revision 9.0
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4. Connect the jumpers on the SmartFusion2 Advanced Development Board as specified in the
following table.
Caution: Switch OFF the power supply switch, SW7, before connecting the jumpers.

Table 4 « SmartFusion2 Advanced Development Kit Jumper Settings

Jumper Pin From Pin To Comments

J116, J353, J354, J54 1 2 Default jumper settings for the SmartFusion2
1123 5 3 Advanced Development Board

J124, J121, J32 1 2 JTAG programming through FTDI

J118, J119 1 2 Programming through SPI flash

For information about jumper locations, refer to Appendix 3: Jumper Locations, page 25.

5. Connect the power supply to the J42 connector in the SmartFusion2 Advanced Development Kit.
6. Depending on the IP mode you want to use for the design, connect one of the following to the J21
connector of the SmartFusion2 Advanced Development Kit Board using an RJ45 cable.
*  For static IP mode, connect the host PC.
«  For dynamic IP mode, connect any one of the open network ports.
Note: By default, programming files are provided for dynamic IP mode. To run the design in static IP mode,
refer to Appendix 4: Running the Design in Static IP Mode, page 26.

251 Board Setup

2.6

For snapshots of the SmartFusion2 Advanced Development Board setup for the demo design, refer to
Appendix 2: Board Setup for Running the Demo, page 24.

Running the Demo Design

In order to run the demo design, perform the following steps:

1. Download the demo design files from http.//soc. microsemi.com/download/rsc/?f=m2s_dg0472_df.
2. Switch ON the power supply switch (SW7).
3. Start a serial terminal emulation program such as HyperTerminal, PuTTY, or TeraTerm.

Note: For this demo, HyperTerminal is used.

4. Configure the program’s serial terminal settings as follows.
+ Baud Rate: 115200
«  Eight data bits
*  One stop bit
*  No parity
*  No flow control
For more information about configuring serial terminal emulation programs, refer to Configuring
Serial Terminal Emulation Programs Tutorial.

Microsemi Proprietary DG0472 Revision 9.0 11
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2.6.1 Running Webserver Demo
The following steps describe how to run the Webserver demo.

1. Program the SmartFusion2 Advanced Development Kit board with the job file provided as part of the
design files using FlashPro Express software, refer to Appendix 1: Programming the Device Using

FlashPro Express, page 21.
The HyperTerminal window displays a welcome message with an IP address, as shown in the

following figure.
Figure 8« HyperTerminal with IP Address

B ' webserver - HyperTerminal o
Eile Edit View Call Transfer Help
D B8 0B

L] Welcome to SmartFusion2 Webserver TCP Demo H

Initializing the MAC and getting IP Address

m

Use the following IP address to browse the Hebserver

Requested IP address : 10.60.3.25

Connected 0:00:43 Auto detect 57600 8-N-1 NUM

2. Open a web browser, and enter the IP address displayed on the HyperTerminal window in the
address bar of the browser.
The SmartFusion2 Webserver demo main menu appears, as shown in the following figure.

Figure 9+ Webserver Demo Main Menu
([ R — ol ) — == *

=) PNR———
{7} smartFusion2 Webserver | + ‘ -

€& | @ 10603.25/indexhtrml ¢ | |B-~ Google P ¥ A B~ Feedback v

& Microsemi

SmartFusion2 Webserver
Demonstration

For More information about SmartFusion2 products, refer to the Microsemi SoC Products website:

http://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2 L

3. Click RTC and Ethernet Interface data display.
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Figure 10 » Selecting RTC and Ethernet Interface Data Display
T e QPG -— el
& 1060325/ nder bl ¢ |[B- coogle P & A B Feedback ~
& Microsemi

SmartFusion2 Webserver
Demonstration

RTC and Ethernet Interface data display
Blinking LED's

HyperTerminal Display
SmartFusion2 Google Search

o]

For More information about SmartFusion2 products, refer to the Microsemi SoC Products website:
http://www.microsemi.com/products/fpga-soc/soc-fpaga/smartfusion2

I

10603.25/RTCdsta

Figure 11 = Webserver RTC and Ethernet Interface Data Display
G [+ ]

o S B P PG ® At Bme g e e G W

The following web page appears, displaying RTC values and Ethernet MAC properties.

l Dﬁ-g
|| B- Googte 2 & A K~ Feedback v
RTC and Ethernet Interface data display
Real Time Counter
Time: 091544
Ethernet Interface Date: 150712013 L
MAC Address: c0'b1:3c:88:88:88
TCPIIP Address: 10.60.3.25 Change RTC value
Speed: To00tops Time (hh:mm:ss):  09:15:35
Date (ddimmiyy):  15/07/13
4. Click Home to go back to the main menu.
5. Click Blinking LEDs on the main menu.
Figure 12 »+ Selecting Blinking LEDs
(DTS

(] smartFusion2 Webserver

[+

% 10,60.3.25/indexhtml

- —

— -y -

o

o[
¢ | |B - Google

L ¥ A E- Feedback ~
& Microsemi

SmartFusion2 Webserver
Demonstration

RTC and Ethernet Interface data display
I Blinking LED's |

HyperTerminal Display

SmartFusion2 Google Search

m

http:

For More information about SmartFusion2 products, refer to the Microsemi SoC Products website:
'www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2

toggle LEDs manually.

The LEDs on the board start blinking, and a web page appears, with an option to enter a value to

Microsemi Proprietary DG0472 Revision 9.0
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Figure 13 »+ Entering Values for LEDs to Blink

[FFrerce| E - I _—
| nttpr#10.60.2.25/LED [+] [
€ 106032560 ¢ |[B- Google P % @ B Feedback -

Blinking LED's

LEDs on the board should blink once from 1 to 255
To blink LEDs manually enter any value between 1 to 255 :251

I

Home

6. Enter any number between 1-255 to toggle the LEDs manually.
Because the SmartFusion2 Advanced Development Kit has active-low LEDs, if 1 is entered, LED1
goes OFF; if 255 is entered, all the eight LEDs go OFF.

7. Click Home to go back to the main menu.

8. Click HyperTerminal Display on the main menu.
Figure 14 » Selecting HyperTerminal Display
(S —— v—‘—" —— g -— . o B>

! SmantFusion2 Webserver | + ‘

€& | @ 10603.25/indexhtrml ¢ | |B-~ Google P ¥ A B~ Feedback v

& Microsemi

SmartFusion2 Webserver
Demonstration

RTC and Ethernet Interface data display

I HyperT |
SmartFusion2 Google Search

For More information about SmartFusion2 products, refer to the Microsemi SoC Products website:

http://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2

A web page appears with an option to enter a string value to be displayed in HyperTerminal.

Figure 15 « Webserver HyperTerminal Display
Jumu —_ —_ = =
£ http://10.60.3.25/HyperTerminal

€ @ 1060325/ HyperTerminal ¢ | |8~ Google P ¥ fi K- Feedback ~

HyperTerminal Display

I

Enter string to display on HyperTerminal: SmartFusion2) -

Home

9. Enter the desired string value, and click Submit.
The following message appears, indicating that the string was successfully submitted.

Microsemi Proprietary DG0472 Revision 9.0 14
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Figure 16 » String Display on HyperTerminal
¢ - paromiot R =

DE »3 OB

Submitted string is SmartFusion?

< [T
115200 8-N-1 | SCROLL CAPS | NUM | Capture

-

Connected 0:01:53 Auto detect

10. Click Home to go back to the main menu.
11. Click SmartFusion2 Google Search on the main menu.

Figure 17 « Selecting SmartFusion2 Google Search

! SmantFusion2 Webserver

€& | @ 1060.3.25/indexhtml

SmartFusion2 Webserver
Demonstration

RTC and Ethernet Interface data display

B

For More information about SmartFusion2 products, refer to the Microsemi SoC Products website:
http://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2

- e | — — ——
el Se— - N —
¢ |[B- Google Pl ¥ A B~ Feedback ~

Note: An Internet connection is required to access the SmartFusion2 Google Search page

A web page appears, with the SmartFusion2 Google Search option.

Figure 18 » Webserver SmartFusion2 Google Search

:-Ehg
L

P & A [+ Feedback v

: — _
L I e
¢ || B- Googie

J SmartFusion2 Google Search

€ | @ 10603.25/google_search.htm

SmartFusion2 Google Search

Microsemi

[_searon | ~

12. Click Home to go back to the main menu.

15
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2.6.1.1 Running the TFTP Demo
The following steps describe how to run the TFTP demo.
1. To enable the TFTP client in the host PC, navigate to Control Panel > Programs and Features.

2. Click Turn Windows Features On or Off, select TFTP Client in the Windows Features dialog box,
and click OK, as shown in the following figure.

Figure 19 « Enabling TFTP Client in Host PC

f =@ = ]
@K‘:jv| » Control Panel » Programs » - | g | | Search Control Panel e |
Control Panel H -
e l:j Programs and Features
h‘ Uninstall a pregram E'l' Turn Windows features on or cf'FI View installed updates

System and Security
Run programs made for previcus versions of Windows | How to install a program

Network and Internet
Default Programs
Change default settings for media or devices | Make a file type always open in a specific program

* Programs Set your default programs

Hardware and Sound

User Accounts

| Desktop Gadgets
; e -2 Add gadgets to the desktop | Get more gadgets online | Uninstall a gadget
o ation Restore desktop gadgets installed with Windows
Clock, Language, and Region

Ease of Access é) Java ” n
— Windows Features = = g

Turn Windows features on or off (7]

Appearance and

To turn a feature on, select its check box. To turn a feature off, clear its
check box. Afilled box means that only part of the feature is turned on.

[[] 1 Simple Network Management Protocol (SNMP) -
[] | Simple TCPIP services (i.e. echo, daytime etc)
| Tablet PC Components
0 . Telnet Client
0 | Telnet Server

TFTP Client .
. Windows Gadget Platform

[[] |, Windows Process Activation Service
. Windows Search
0 . Windows TIFF IFilter
| KPS Services
[V 1L XPS Viewer

m

3. Navigate to Control Panel > Windows Firewall, and click Turn Windows Firewall On or Off.
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4. Select Turn off Windows Firewall under Domain network location settings, and click OK, as
shown in the following figure.

Figure 20 - Windows Firewall Settings

mv|0 v Control Panel » All Control Panel ltems » Windows Firewall » Customize Settings

Customize settings for each type of network
You can modify the firewall settings for each type of network location that you use.
What are network locations?
Dorain network location settings
™ /1 () Turn on Windows Firewall
- Block all incoming cennections, including those in the list of allowed programs

Notify me when Windows Firewall blocks a new program

| I@] @) Turn off Windows Firewall (not recommended)

Home or work (private) network location settings
™ /1 @) Turn on Windows Firewall

[T Block all incoming connections, including those in the list of allowed programs

Notify me when Windows Firewall blocks a new program
I@] () Turn off Windows Firewall (not recommended)
Public network location settings
™ /1 @) Turn on Windows Firewall

[T Block all incoming connections, including those in the list of allowed programs

Notify me when Windows Firewall blocks a new program

I@] () Turn off Windows Firewall (not recommended)

5. Launch the FlashPro Express software, and program the device with the
Webserver TCP top tftp.job file located at
<download_folder>\SF2_Webserver_Tftp_TCP_Demo_DF\ProgrammingFiles\Tftp_Server\. Wait
until the PROGRM PASSED message is displayed. (Refer to steps 1 to 9 of Appendix 1:
Programming the Device Using FlashPro Express, page 21.)
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The HyperTerminal window displays a welcome message with an option to clear SPI flash contents,
as shown in the following figure.

Figure 21 » HyperTerminal Welcome Message

#  Tftp - HyperTerminal EIL .

File Edit View Call Transfer Help
O @& 5 DB

| »

=xxxxxxx  Welcome to SmartFusion? TFTP Demo xx=xxxxxxx
Do vou want to erase SPI Flash Wemory?y/n

m

1| 11 [

Connected 0:00:12 Auto detect 115200 &-M-1 SLRULL CAPS | Num | Capture | Print echo

6. Typey to erase SPI flash memory, as shown in the following figure.
Figure 22 » Erasing SPI Flash Memory

-
B o e
|| File Edit View Call Transfer Help 1

Ow & & Dy @& ||

| »

xxxxxxxx  Welcome to SmartFusion? TFTP Demo sex=xxsxxxxxx
Do vou want to erase SPI Flash WMemory?y/n

m

SPI Flash Hemory 1is erasing ... wait..
SPI Flash Memory 1s erased successfully.
Initializing the MAC and getting IP Address ..wait. .

Use the following IP address to transfer a file
from host PC to SmartFuison? SPI Flash using TFIP
Requested IP address : 10.61.10.130

1| 11 [

Connected 0:05:13 Auto detect 115200 8-N-1 SCROLL CAPS | MUM | Capture | Print echo
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7. Type any key other than y to avoid erasing SPI flash.
The HyperTerminal program displays a dynamic IP address, as shown in the following figure.

Figure 23 » HyperTerminal with Dynamic IP Address
File Edit View Call Transfer Help
O =& A2 DBy

xxxxxxxx  WHelcome to SmartFusion? TFTP Demo =xxxxxxxxxx
Do you want to erase SPI Flash Memory?v/n

Initializing the MAC and getting IP Address ..wait. .

Use the following IP address to transfer a file
from host PC to SmartFuison?2 SPI Flash using TFTP
Requested IP address : 10.61.10.138

4

Connected 0:00:21 Auto detect 115200 8-M-1

8. Open the command prompt on the host PC, and navigate to the directory where the files to be
transferred to the SPI flash are located:
<download_folder>\SF2_Webserver Tfto TCP_Demo_DF\sample_files

9. Select a file that needs to be transferred, and type the following TFTP command to transfer the file to
the TFTP server (the SmartFusion2 device):
tftp -1 < ip address> PUT <file name>

Figure 24 + Command Prompt

BN Command Prompt |£|Elﬂ_hj

D:vsf2_wehserver_tftp_tcp_demo_dfssample_files>tftp —i 18.68.2_4 PUT 7?.html_

v

Upon successful file transfer from the host PC to the SmartFusion2 SPI flash, the command prompt
displays a message indicating that the transfer was successful.

Figure 25 « Successful Transfer Message

BN Command Prompt |i|ﬂli:—hj

D:~zf2 webserver_ tftp tcp demno_dfsample files>tftp —i 18.68.2_4 PUT 7.html
Transfer successful: 54621 bytes in 3 seconddsz>. 18287 bytes.-=

D:~sf2 webserver_ tftp tcp deno_dfsample filesz>_
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HyperTerminal displays the available files in SPI flash, as shown in the following figure.
Figure 26 » HyperTerminal with Available SPI Flash Files
i Tftp - HyperTerminal EIL ]
|l File E;; View Call Transfer Help
O @ & 0\

#HH#E  Avallable files in spi-flash  #Hi# -
171 .HTH
271 .HTH 6892
371 .HTH 21576
471 HTH 136
571 HTH 21576
671 . HTH 37498
771 HTH 54621
871 HTH 82712
8 File(s), 242363 bytes
0 Dir(s) ‘_‘
1| 1 | +

Connected 0:06:46 Auto detect 115200 8-N-1  SCROLL CAPS 'NUM | Capture | Print echo

10. Repeat steps 9 and 10 for any additional files that need to be transferred from the host PC to the
SmartFusion2 SPI flash.
11. After running the demo, close the HyperTerminal window.
Note: To run the SoftConsole project in debug mode, refer to Appendix 5: Running the SoftConsole Project in
Debug Mode, page 29. To run the design from DDR memory, refer to Appendix 6: Running the Design
from DDR Memory, page 31.
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3 Appendix 1: Programming the Device Using

FlashPro Express

This section describes how to program the SmartFusion2 device with the programming job file using

FlashPro Express.

To program the device, perform the following steps:

1. Ensure that the jumper settings on the board are the same as those listed in Table 4, page 11.
Note: The power supply switch must be switched off while making the jumper connections.

aokrwbd

Figure 27 » FlashPro Express Job Project

@ FlashPro Express

Project Edit View Programmer Help

Job Projects

New...
Open...

Recent Projects

or

Connect the power supply cable to the J42 connector on the board.
Power ON the power supply switch SW7.

On the host PC, launch the FlashPro Express software.
Click New or select New Job Project from FlashPro Express Job from Project menu to create a
new job project, as shown in the following figure.

[Z2 FlashPro Express

Project | Edit View

I = Open Job Project
¥ Close Job Project

I Savelob Project

Set Log File

Export Log File
Preferences...

Execute Script
Export Script File...

Recent Projects

Exit

Mew Job Project from FlashPro Express Job

Programmer Help

Ctrl+N
Ctrl+0

Ctrl+Shift+A

Ctri+U

Ctrl+Q

6. Enter the following in the New Job Project from FlashPro Express Job dialog box:

Programming job file: Click Browse, and navigate to the location where the .job file is located and
select the file. The default location is:

<download folder>\m2s_dg0472 df\Programming Job
* FlashPro Express job project name: Click Browse and navigate to the location where you want to

save the project.
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Figure 28 « New Job Project from FlashPro Express Job
@ lew Job Project from FlashPro Express Job A

IProgramming job file: I

Browse...

FlashPro Express job project name:
i
IFIashPro Express job project location: I

] Browse...

Help OK | Cancel ]

-

Click OK. The required programming file is selected and ready to be programmed in the device.

8. The FlashPro Express window appears as shown in the following figure. Confirm that a programmer
number appears in the Programmer field. If it does not, confirm the board connections and click
Refresh/Rescan Programmers.

~

Figure 29 » Programming the Device
Project View Tools Help

| Refresh/Rescan Programmers |

Programmer

O m2s000T 1

<3 TDO DI 2

j O & [0a435 IDLE IDLE

m
RUN ‘ IDLE

9. Click RUN. When the device is programmed successfully, a RUN PASSED status is displayed as
shown in the following figure.
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Figure 30 » FlashPro Express—RUN PASSED
Project View Tools Help

Refresh/Rescan Programmers |

@ M25000T
Programmer

o o[ APRSHNN IASEHI

=

PROGRAM -
an  LPROGRAMMERS)PASSED
Log 8 %
[E]Messages € Errors & Warnings @ Info
programmer '94435' : device 'M2S090T' : Finished: Wed Apr 7 17:30:51 2021 (Elapsed time :I
ggogiarzmi()er '94435" : device 'M2S090T' : Executing action PROGRAM PASSED.
programmer '94435' : Chain programming PASSED.

Chain Programming Finished: Wed Apr 7 17:30:51 2021 (Elapsed time 00:01:28)

-0 -0 -0 -0 -0
v

10. Close FlashPro Express or in the Project tab, click Exit.
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4 Appendix 2: Board Setup for Running the
Demo

The following figure shows the board setup for running the demo on the SmartFusion2 Advanced
Development Board.

Figure 31 « SmartFusion2 Advanced Development Board Setup

T
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5 Appendix 3: Jumper Locations

The following figure shows the jumper locations on the SmartFusion2 Advanced Development Board.

Figure 32 + SmartFusion2 Advanced Development Kit Silkscreen Top View

T g

o

R267 53¢

7351

O

by DS17 Rag2
} %0 L0

RRIS2 ) ¢ Ruge

Note: Jumpers highlighted in red in the figure are set by default; jumpers highlighted in green must be set
manually.
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6 Appendix 4: Running the Design in Static IP

Mode

The following steps describe how to run the design in static IP mode.

Note: This procedure provides steps to run the Webserver design. To run the TFTP server design, perform the
same steps by selecting the TFTP_Server project in SoftConsole.

1. In SoftConsole Project Explorer window, right-click the Webserver project, and select Properties,
as shown in the following figure.

Figure 33 « SoftConsole Project Explorer Window

[7 Project Explorer 52 H <;==(>| ¢ - — 0O
+ (25 TFTP Server
4 |5 Webseryar
> g'c’;b Bina New 3
> [ Incl Go Into
> (= App , ,
» = CMS Open in Mew Window
= De.b Z| Copy Ctrl+C
> (= driv )
. = driv Paste Ctrl+V
> 7= Free| 3 Delete Delete
> = hal Remove from Context Ctrl+Alt+Shift+Down
> (& wip Source 3
> [= mss, Maw
- = Rele YOS
. [k Free Rename... F2
> [8 mai s Import.
s [ msc
. [n] 5B by Export..
g % =YE- Build Project
5Ys,
’ ye- Clean Project
&1 Refresh F5
Close Project
Close Unrelated Projects
Build Configurations »
Make Targets 3
Index 3
Show in Remote Systems view
Profiling Tools »
Profile As 3
Debug As 3
Run As 3
Compare With 3
Restore from Local History...
#7  Run C/C++ Code Analysis
Teamn k
I Properties Alt+Enter I
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2. In the Tool Settings tab of the Properties for Webserver window, remove the NET_USE_DCHP
symbol, and click OK, as shown in the following figure.

Figure 34 » Webserver Properties Window

-
S§C Properties for Webserver

-

")

type filter text

> Resource
Builders
4 C/C++ Build
Build Variables
Environment
Legging
Settings
Teol Chain Editor
Teals Paths
» C/C++ General
Linux Teols Path
Project References
Run/Debug Settings
» Task Repository

Settings

| »

Configuration: [ Release [ Active ]

'] [ Manage Configurations... ]

&3 Tool Settings | %3 Toolchains I # Build Stepsl

Build Artifact | Binary Parsers | 3 Error Parsers|

@ Target Processor
(# Optimization
@ Warnings
(% Debugging
4 %) Cross ARM GNU Assembler
(22 Preprocessor

[7] Do not search system directories (-nostdinc)

[T] Preprocess only (-E)
Defined symbols (-D)

m

88 84 &

LWIP_COMPAT_MUTEX

LWIP_PROVIDE_ERRMO

@ Includes

MICROSEMI_STDIO_THRU_MMUARTO

WikiText

(2 Warnings
@ Miscellaneous
4 [ Cross ARM C Compiler
@ Preprocessor
(2 Includes
@ Optimization
(2 Warnings

@ Miscellanecus

oK ] l Cancel

3. Change the host TCP/IP settings to reflect the board’s static IP address, 169.254.1.23.
The following figure shows the host PC TCP/IP settings.

Figure 35 «

Host PC TCP/IP Settings

F
[l Local Area Connection Properties

S

Networking

Connect using:
L¥ Broadcom Netlink (TM) Gigabit Ethemet

This connection uses the following tems:

& Cliert for Microsoft Networks

QQDS Packet Scheduler

gﬁle and Printer Sharing for Microsoft Netwarks

i Broadcom Advanced Server Program Driver

& |ntemet Protocol Version & (TCP/IPVE)

B ntemet Protocol Version 4 (TCP/IPv4) |

=& Link-Layer Topology Discovery Mapper 1/0 Driver
& Link-Layer Topology Discovery Responder

Description

Uninstall

wide area network protocol that provides communication
across diverse interconnected networls.

Transmission Control Protocol/Intemet Protocol. The defautt

oK || Cancsl
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The following figure shows static IP address settings.
Figure 36 » Static IP Address Settings

r B
Internet Protocel Version 4 (TCP/IPvd) Properties m

General

You can get IP settings assigned automatically if your network supparts
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@) Use the following IP address:

IP address: 169 . 254, 1 . 22
Subnet mask: 255,255,255 . 0
Default gateway:

Obtain DNS server address automatically

@) Use the following DNS server addresses:
Preferred DNS server: 169 .254. 1 . 23

Alternate DMS server:

[[validate settings upon exit

[ OK ][ Cancel ]

|

4. After configuring the settings, compile the design, load it into memory, and run it using SoftConsole.
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7 Appendix 5: Running the SoftConsole Project
in Debug Mode

The following steps describe how to run the SoftConsole project in debug mode.
1. In SoftConsole, select Run > Debug Configurations.

The Debug Configurations dialog box is displayed.
2. Select the appropriate project:

+  To debug the TFTP_Server project, select TFTP_Server Debug, as shown in the following
figure.

Figure 37 « Debug Configuration for TFTP_Server

-
SC Debug Configurations

Create, manage, and run configurations

—+l

x| = Mame: TFTP_Server Debug

fi

G
|

Mainl #;? Debugger| = Startup| E:/ Source| 5| Qomm0n|
4 GDB OpenQCD Debuggin .
i@ TFTP Server Debugi Broject I
[c | Webserver Debug TFTP_Server

C/C++ Application:
Debug/TFTP_Server.elf

»

Variables... ] lSearcﬂ Project...l [ Browse... ] E
Build {if required] before launching
Build configuration: | Use Active v]
() Enable auto build () Disable auto build

@ Use workspace settings Configure Workspace Settings...

4 [T | *

. R Apply Revert
Filter matched 3 of 9 items —

I ® Debug l [ Close
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Figure 38 «

Debug Configuration for Webserver
.
SC Debug Cenfiguraticns

& Microsemi
To debug the Webserver project, select Webserver Debug, as shown in the following figure.
Create, manage, and run configurations

a AS\MicrocHip company
T [EF= -+,
L1 ESl X | H Name: Webserver Debug
type filter text Main] %3'- Debugger| [ Startup| Y Source| S| Qommon|
4 [c| GDB OpenOCD Debugg .
— Project:
lc | TFTP Server Debug
| [c | Webserver Debug Webserver
C/C++ Application:
Debug/Webserver.elf
| |

Build (if required) before launching

Browse...

Variables... ] [Search Pro»ject...] ’ Browse... ]
Build configuration: | Select Autormatically vl
() Enable auto build () Disable auto build
@ Use workspace settings Configure Workspace Settings...
] T r
) ) Apply Revert
Filter matched 3 of 9 items
® Debug | [ Close
3. Click Debug.

Microsemi Proprietary DG0472 Revision 9.0

30



Appendix 6: Running the Design from DDR Memory O M. .
icrosemi

a AS\MicrocHip company

8 Appendix 6: Running the Design from DDR
Memory

This appendix describes the changes to be made to the Libero SoC and SoftConsole projects in order to
run the demo design from DDR memory.

8.1 Changes to Libero SoC Project
Open the project in Libero SoC, and perform the following steps.

1. In the System Builder, enable MDDR, as shown in the following figure.
Figure 39 » System Builder Device Features
O R e B e — =R

> Device Features Memories ) > Peripherals » 7 Clocks Micracontroller » > SECCED Security Interrupts Memory Map >

Select the SmartFusion2 features you will be using in your design

Memory

M55 External Memary I
: ==
() Soft Memory Cantroller (SMC)
=t

M55 On-chip Flash Memary ( ehivi )

ey

i

[] Fabric External DDR Memory { FODR )

High Speed Serial Interfaces

[] SERDESIF_O
[] SERDESIF_L
[7] sERDESIF_2
SERDESIF_3

ISR
TR e o]
AN A L

Microconkroller Options
‘Watchdog Timer
Peripheral DMA
Real Time Counter

=Dk
SFRE NVE
4365 RO K %

o

AL ST

[E5] =
CORESCR

E E

EERCES

|
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2. Configure the DDRS settings as indicated in the following figure.
Note: The DDR configuration file, DDR_Config. txt, is available at:
<download_folder>\SF2_Webserver_Tfto_TCP_Demo_DF\sample_files\DDR_Config\

Figure 40 + System Builder Memories
“MDDR "\ ERVF\ DDR mematy settling time (usk: 200 HDDR \/ERWM \.

DR memary settling time (us): 200

DR memary settling time (us) 200

[1mport Configuration| [Export Configuration| [Restors Defauls|
import Configuration| [Expert Configuration| [Restore Defauts| General | Memory Inialization | Memory Timing | [import. Canfiguration| [Expert Configuration| [Restore Defaults|
General | Memory Intialization | Memory Timing | Burst Length B ] Bis General | Memory Intialization | Memory Timing
Burst Order Interleaved -
Memary Settings C ] Tite ta Hald Reset before IIT 6758+ s
Memry Type = 2 Tiring Made (a7 =) . s
— 5 ] CAS Lakency (e > ks
atka Wi - "
B — s R ) s e
SECDED Enabled ECC
ko Refresh Burst Count (8 L3 RAS (Max ) 8192 Clks
Artitration Scheme  [Type-0 -]
Enabled [¥Es. -] RED A ks
Highest Priority D |0 Stop the Clock e
RP 7 Chs
Address Mapping RO, BANK, COLUMN} Deep Powerdown Enabled (MO
Row Bank Column Poerdown Ertry Time 152 REF1 3104 s
Address width (bits) (16 RIE +] |10 - Additive CAS Latency [0 ] cks RC st Chs
CAS Write: Latency 5 Chs X 3 Chs
10 Drive Strength st — -
° ) qin oE 3 ks
© Half Drive Strength () Ful Drive Strength 20 6 ks
RFC 7% Chs
7QCS Interval 5389632 ks
Local 00T (Enable durin read transaction -] WR 6 Chs
Drive Strength [Rzoje ) Faw 2 Chs
REE_NOM (Disable -]
Rtt_WR [ -]
Auto Self Refresh [Manual -]
Self Refresh Temperature [Mormal -]

3. Generate the programming file, and program the board.
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Changes to SoftConsole Project for Debug Mode

To run the project in debug mode, perform the following steps in SoftConsole.

1. In the Project Explorer window, right-click the Webserver project, and select Properties.
Figure 41 » Selecting Webserver Properties

[ Project Explorer 53

> ET? TFTP_Server

4 i?? Webse
[ MNew 3
> 3%, Bin
. [ Incl Go Into
> i AP Open in MNew Window
> = CM
> = Deb 2 Copy Ctrl+C
> (= driy Paste Ctrl+V
b (2= dri
i Fre W Delete Delete
. = hal Remove from Context Ctrl+ Alt+Shift+ Down
> i lwig Source 2
> [ ms Move...
> (& Rel Rename... F2
> [l Fre
> [ ma s Import.
> [g ms By Export..
- [n] SB_
s [ sys) Build Project
> (B sys] Clean Project
&1 Refresh F5
Close Project
Close Unrelated Projects
Build Configurations 2
Make Targets 3
Index »
Show in Remote Systems view
Profiling Tools »
Profile As 3
Debug As 4
Run As »
Compare With »
Restore from Local History...
%’* Run C/C++ Code Analysis
Team »
I Properties Alt+Enter I
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2. Setthe debug-in-microsemi-smartfusion2-external-ram.1d linker script file, as shown

in the following figure.
Figure 42 » Setting the Script File

rSCPerertiestrWEbsewer' ™~ avesg*e . “-..‘-. e L‘:' @g
type filter text Settings - v v
> Resource
Builders -
4 Configuration: [DEbUQ [ Active ] '] [Manage Configurations...
Build Variables
Environment
Logging % Tool Settings | 5] Too\chain;l A Build Step;l Build Artifactl Binary Par;er;l @ Error Parsers
E
Tool Chain Editor (22 Target Processor Script files (-T) & & &8 52
5
. C[C‘ZUf:::at:\ g: Sv:tr‘:rllz;:mn '$lworkspace_loc/${ProjNamel/CMSIS/startup_gcc/debug-in-microsemi-smartfusion2-external-ram.|d}|
Linux Tecls Path (% Debugging
Project References » B3 Cross ARM GNU Assembler —
Run/Debug Settings > B3 Cross ARM C Compiler
» Task Repository 4 53 Cross ARM C Linker
| WikiText General
(22 Libraries
@ Miscellaneous
4 83 Cross ARM GNU Create Flash Image
@ General
4 5 Cross ARM GNU Print Size
@ General il
® [ 0K ] [ Cancel ]
3. Build the SoftConsole application, and select Run > Debug Configurations, as shown in the
following figure.
Figure 43 » Selecting Debug Configurations
SC C/C++ - Webserver/main.c - Microsemi SoftConscle v4.0
File Edit Source Refactor Mavigate Search Project | Run| Window Help
- SRR R = R & @ Run Ctrl+F11
- 4, Debug F11
- Project Explorer 53 I Q. Profile
o 1% TFTP Server
i Ei‘; Wehserver Profile History 2
s g’;ﬁ Binaries Profile As 4
> [nf/! Includes Profile Configurations...
» 4= Application
» 2= CMSIS Run History 2
> (= Debug Run As 2
> & dr!vers ] Run Configurations...
» = drivers_config
: = FreeRTOS Debug History L4
s (7= hal Debug As b
7= Iwip-1.4.1
> = lwip I Debug Configurations... I
» = mss_ethernet_mac
> (= Release Teggle Breakpoint Ctrl+Shift+B
> [ Fre_eRTOSConflg.h Teggle Line Breakpeint
> ] main.c .
» [§] msce_post_hw_cfg_init.c Teggle Method Breakpoint
+ [0 SB_hw_platform.h Toggle Watchpoint
s €] sys_cfg.e &, Skip All Breakpoints
+ [n] sys_cfgh ‘5z Remove All Breakpoints
p
Breakpoint Types 2
Q. Edernal Tools 2
4. In the Debug Configurations window, go to the Debugger tab.
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5. In the config options field, replace the existing value with -file board/microsemi-
smartfusion2-dev-kit-ddr.cfg, as shown in the following figure.
Figure 44 » Debug Configurations Window

f -
SC Debug Configurations e v

Create, manage, and run configurations

CIEE

i

Mame: Webserver Debug

Main ﬁ Debuggerl [ Startup| E/ Source‘ S| Qommon|

OpenOCD Setup
Start OpenOCD locally

Executable: S{openocd_path}/S{openocd_executable}

GDE port: 3333

O
|

4 [c] GDB OpenOCD Debugging
Webserver Debug

»

Telnet port: 4444

m

Config options:  ..command "set DEVICE M25150" [-file board/microsemi-smartfusion2-dev-kit-ddr.ctg |

Allocate console for OpenOCD Allocate console for the telnet connection

I GDE Client Setup T
Executable: §{cross_prefix}gdb${cross_suffix}
Other options:
Commands:

set mem inaccessible-by-default off

X X Apply Revert
Filter matched 2 of 9 items =

@ (

Debug ] [ Close

6. Click Debug to run the project from DDR memory in debug mode.
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